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Introduction

Conventions Used in this Document

This document uses the following conventions:

not incl

{

%

e

The names of screens, windows, fields, and other features displayed by the software are shown
in bold type.

Information you enter into the software is in bold type, as in the following example: Enter
Miscellaneous in the Amount Type box.

Names of keys are shown in capitals; for example, ENTER, TAB. A plus sign (+) between two key
names indicates that you should press both keys at the same time; for example, SHIFT + TAB.
The names of buttons you can click with your mouse are enclosed in bold type; for example, [OK]
and [Post].

Helpful information to make your experience better.

NOTE: This symbol draws your attention to information of particular interest, such as information
uded in steps.

CAUTION: This symbol draws your attention to information that is important because it can help

you avoid a costly or time-consuming error.

IMPORTANT: This symbol draws your attention to information that is of critical importance.
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Introduction

MyAssistant Upgrade Guide

This document steps you through the upgrade and configuration of the Sage 300 CRE MyAssistant software.
If you are installing the MyAssistant software for the first time please refer to the MyAssistant Installation
Guide included in the MyAssistant installation files.

Upgrading the MyAssistant software consists of the following steps.

1. Upgrade the MyAssistant Server software.

2. Reactivate the MyAssistant Server software by stepping through the MyAssistant Configuration
Wizard.

3. (Optional) Upgrade the MyAssistant Drive Mapper.

4. Upgrade MyAssistant on the desktop computers or Terminal/Citrix Servers where MyAssistant is
used.

5. Depending on a number of settings, you may be asked to reactivate the software on the
workstation(s).

Upgrading and configuring the MyAssistant server should take approximately 30 minutes. Upgrading each
MyAssistant workstation should take approximately 10 minutes.

IMPORTANT: A time synchronization service such as Windows Time Service must be
activated on all machines where MyAssistant is installed.

E CAUTION: Itis important that the MyAssistant software is upgraded via a supported upgrade
path. The following chart outlines the supported upgrade paths based on the version of the MyAssistant
software you are currently running.

To determine what version of the MyAssistant software you are currently running, open the software and
select File > Help > [About]. The window that opens will show you the version of the software.

Review the table below for the supported MyAssistant upgrade paths.

Current MyAssistant Version MyAssistant Upgrade Path
4.0 and higher Upgrade directly to MyAssistant 14.1
3.x or earlier Upgrade to MyAssistant 4.2, then upgrade to MyAssistant 14.1

If you upgrade from an unsupported path you risk corrupting your MyAssistant data.
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Introduction

Before You Begin

e Create a backup of your MyAssistant database prior to upgrading the software.

e Determine the computer where the MyAssistant server software is currently installed. It is most likely
on your Sage 300 CRE server.

e Ensure the latest Microsoft Windows and Microsoft Office updates have been installed. Installing the
High Priority updates is recommended.

e Gather your MyAssistant Product Keys and Customer Number.

e You must be running Sage 300 CRE on all machines on which MyAssistant will be installed. This
includes the MyAssistant server.

Restart the MyAssistant Server prior to performing the upgrade. This will complete any Windows
or other software updates where a restart is required.

Support and Training

Telephone Support

When you would like to speak to a customer support analyst directly, call us at 800-551-8307. Telephone
support is available Monday through Friday from 6 a.m. to 5 p.m. Pacific Time with the following
exceptions:

e Every Thursday from 2 p.m. to 3 p.m. Pacific time (closed for customer support staff meetings)

e Standard United States holidays

e Quarterly company meetings

Sage Customer Portal

You may log on to the Sage Customer Portal at:
https://customers.sagenorthamerica.com/irj/portal/anonymous/login.

The portal provides access to the following services:

o Knowledgebase: Find answers to your questions, access downloads, and subscribe to your
favorite articles. This service is available online 24/7.

e Live Chat: Chat online with a customer support analyst, a great option for quick questions. Chat
hours are Monday through Friday from 6 a.m. to 3 p.m. Pacific Time, with the same exceptions as
telephone support.

¢ Online Support Request: If you have a question or an issue that is not urgent, you can submit an
online support ticket. A customer support analyst will contact you during regular telephone
support hours.

Upgrade Guide Page 7
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Introduction

Training

Sage University
Sage University offers both recorded and live training sessions. Visit SageU.com for currently available
and upcoming classes.

How to access MyAssistant training options in Sage University:

Enter www.SageU.com in your web address bar.

Click [Customer Training] and select your Sage 300 Product from the list.

In the page that opens, click [Product Training] on the left side of the screen.

Click [MyAssistant] in the list that opened.

Select either [Realtime Learning] or [Replay Leaning] and review the available options in each.

abhwh =

How to access Complimentary MyAssistant Training in Sage University:
1. Enter www.SageU.com in your web address bar.
2. Click [Customer Training] and select your Sage 300 Product from the list.
3. Click [Complimentary Training] on the left side of the screen.
4. Review the list of complimentary classes for a MyAssistant option.

MyAssistant YouTube Channel
The MyAssistant YouTube channel offers a variety of MyAssistant training videos. Subscribe to the
MyAssistant YouTube channel to be notified when new videos are added.

How to access the MyAssistant YouTube channel:
1. Enter www.YouTube.com/MyAssistantTraining
2. The channel will open with all available videos listed.
3. Click on a video to watch.

Local Business Partner
Contact your local Business Partner to learn what types of MyAssistant training they can provide.

Upgrade Guide Page 8



Backup the Database

Chapter 1 — Back Up the MyAssistant Database

Before upgrading your MyAssistant software, it is important that you backup your current MyAssistant
database.

{%} by navigating to Start > All Programs > Sage > MyAssistant > MyAssistant Configuration

@-I 1. Open the MyAssistant Configuration Manager using the icon on your Desktop (pictured left), or
Manager

2. Navigate to the tab labeled MyAssistant Database Connection

3. Click [Backup Database...] (highlighted below)

@ MyAssistant Server Configuration Manager o B
Product Ativation Connect to the MyAssistant Database 2]
| MyAssistant Database Connection | Use the fields below to enter the computer name where the SQL Server database
is installed and to create a SQL Server user.
Sage 300 CRE Data Folders
Enter the computer that the database is located at:
Notification E-Mail Account Server Name MyAssistantServer
Delivery Options Create a username and password for MyAssistant to access
the 0L Server:
User Name MyAssistant
Password |
Re-enter Password; | FFessssssss
Advanced Connection Settings Test Settings...
Instance name: |I1SD Backup Database...
Database name: |Motification
Port number: 45312
OK Cancel

4. Inthe new window that opens, select the location where the backup of the database will be
stored. A default location will be prefilled, but can be changed by typing into the text box or using
the [...] button to the right of the text box.

Upgrade Guide Page 9



Backup the Database

@ Eackup Database

=

= =2

| Backup Location

Create MyAssistant Database Backup.

Select the location to store the generated backup and dlick the buttan [Backup MyAssistant Database] ta
complete wour backup,

Backup Location: | Ci\Users\Administrator\DocumentsiMyAssistantBackup_06_24_2014.bak

Backup Myassistant Database

5. After selecting a backup file location, click [Backup MyAssistant Database]

6. When the process has completed, the window will change to show a message that says ...

*insert graphic here*

7. After finishing the backup, click [OK].

Now that your MyAssistant database has successfully been backed up, continue with the upgrade of your

MyAssistant software.

Upgrade Guide
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Server Upgrade

Chapter 2 — Uninstall the MyAssistant Desktop Plugin

NOTE: Performing the following is only necessary if upgrading from MyAssistant 4.2 or earlier.

Before upgrading your MyAssistant software, you need to uninstall the desktop plugin program.

This needs to be done on each machine prior to upgrading that machine. Please follow the instructions
below to uninstall the Sage desktop plugin.

1.

2.

Open the control panel on the machine by selecting Control Panel from the Start menu

Open Uninstall a Program or navigate to Programs and Features > Add\Remove Programs
Look down the list of installed programs to find MyAssistant Desktop Plugin

Select the item and click [Remove] or [Uninstall]

When the Desktop plugin has uninstalled successfully, continue with the upgrade.

Upgrade Guide Page 11



Server Upgrade

Chapter 3 — Upgrading the MyAssistant Server
Perform the following to initiate the MyAssistant Server upgrade.

1. Log on to your Sage 300 MyAssistant server with a Windows user that has Administrator or
Unlimited permissions.

2. Confirm that you have closed all applications and disabled any anti-virus or Firewall software that
may be running.

3. Using the link provided by Sage Software, download the MyAssistant installation files and save
the .ZIP file to a folder on your machine. Consider saving the .ZIP file to a shared folder so it is
accessible from any workstations where MyAssistant will be installed. Perform the following to
initiate the MyAssistant Server Upgrade.

a) Open the location of the downloaded MyAssistant Installation files.
b) Unzip the files to a folder on the local drive on the MyAssistant Server.
c) Open the location of the unzipped MyAssistant installation files and double click autorun.hta

4. The Sage 300 CRE MyAssistant Installation hub will open.

Sage 300

Construction and Real Estate

MyAssistant

Version 141

» View Installation Guide.

» Install Server.

v Install Workstation.

SageCRE.com | Exit |

Click [Install Server] to start the MyAssistant Server upgrade.
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Server Upgrade

Step 1 — MyAssistant Server Upgrade

The MyAssistant Installation wizard displays once you have selected the type of install.

m MyAssistant - Setup Server

YWelcome to the Myhssistant Server Instaler

Wialcome

Thiz wizard will guide you through the Mpdssistant inztallation proceszs, vou
may be asked to restart your system after installing prerequisites.

®  Prerequizites

®  MyAssistant

Before continuing inztallation, please cloze all apphcations [such az Microsaoft
Outlook, Wiruz Scanners, and Spuware Detectors), since they can interfers
with the My Aszzistant installation.

Mewt > Cancel

Click [Next] to continue.
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Server Upgrade

Step 2 — MyAssistant License Agreement

You must accept the Innovative Software Design License Agreement to upgrade the Sage 300 CRE
MyAssistant software. A complete copy of the License Agreement is provided with the MyAssistant installation
files.

m MyAssistant - Setup Server

License Terms for MyAssistant Server

License Tems IMPORTANT - READ CAREFULLY: Ths i’
Software License Agreement (the “Agreement™)
15 a legal agreement between you - either an
indiridual or a single entity - the “Licenses™) and
Innovative Software Design, Inc. ("ISD™). This
Agreement applies to the computer software, in
machine readable form, that accompanies this
A greement (the “Software™), updates,
documentation and related serwvices.  TOT
AGEEE TO BE BOUID BY THE TERMS OF
THIS AGEEEMIT BY CLICEING ~I
ACCEPT THE TEEMS OF THIS
AGEEEMENT', IMSTALLING, COPTIIG,
OF TTSING THE SOFTWARE, IF YOU DO
NOT AGEEE, DO MNOT INETALL, COPTY,
OF USE THE S0OFTWARE, YOU MAY
EETURIT IT TO 7YOUE PLACE OF
PURCHASE FOR A FULL EEFTIND.

[
¥ accept the terms in the license agreement

Mest » Cancel |

If you agree to the terms of the License Agreement, check the | accept the terms in the license agreement
checkbox and click [Next] to continue.

Upgrade Guide Page 14



Server Upgrade

Step 3 — Prerequisites for MyAssistant Server

This window displays the prerequisite software that MyAssistant will upgrade.

m My hssistant - Setup Server

Prerequisites for MyAssistant Server

Mudszistant requires the following items to be installed before continuing. Items

Ingtall Prerequisites with a checkmark are already installed on your system:

Windows installer Update
Windows MET 3.5

%

SOL Server Express

%

Crystal Reports Redistributable

[T Donot install SEL Server Eupress

Only check thiz bow if you have installed your own ingtance of SOL Server
Pleaze read the Installation Guide for more information,

MHest > Cancel

This window displays if any of the MyAssistant prerequisites need to be installed or upgraded. The green
check mark indicates that the software is already running the correct version. The blue circle indicates the
software that needs to be installed or upgraded.

CAUTION: Only check the “Do not install SQL Server Express” box if you have separately
purchased, installed and will be using a full version of the Microsoft SQL Server database with
MyAssistant. The MS SQL Server edition (i.e., Full or Express) is not displayed in the list of installed
programs in Windows. Do not check this box if you are unsure whether you have a full version of
Microsoft SQL Server installed. By checking this box you are taking full responsibility for the installation,
setup, and maintenance of the SQL Server instance that MyAssistant will use.

IMPORTANT: The SQL upgrade can take 15-20 minutes. Please be patient. Do not cancel the
SQL upgrade.
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Server Upgrade

Step 4 — MyAssistant Software

In this step you will determine where the updated MyAssistant program files will be installed on your
server.

m MyAssistant - Setup Server E

[y Assistant Server

The default lozation where the Mudsziztant program files will be installed
to iz C:MProgram Fileshlnnowative Software Designhdy Assistanth, ou
may uze the Browse button to zpecify a different location on your local

. camputer.
Inztall Mydzsistant

Select a location to inztall Mudssistant

C:%Program Filez [#E61nnovative Saftware Degigniby desistant

Browse... |

Mest » Cancel

Accept the default location or use the [Browse] button to specify a different location.

Click [Next] to begin the installation of the updated MyAssistant software.
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Server Upgrade

Step 5 - You Have Completed Upgrading the MyAssistant Server

Congratulations, you have completed upgrading the MyAssistant Server.

m MyAssistant - Setup Server

fou have completed instaling Mybssistant Server

Congratulations! ou have finizhed installing the Mydssistant Server, The
Myt zsistant Server must be activated and configured to n. To activate the
gervel, Iuh the Mpdezsistant Configuration Manager.

Finizhed

Click [Finish] to close the wizard and have the option to continue to the Configuration Manager.

NOTE: You must step through the Configuration Manager on the server before upgrading
MyAssistant on any Workstations.
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Server Upgrade

Start the MyAssistant Configuration Manager
After clicking Finish, you will be prompted to start the MyAssistant Configuration Manager.

MyAssistant - Setup Server

% Vour Mydssistant Server needs o be configured befare it can be
V' used,

Do wou wank ko run the MyAssiskant Configuration Manager now?

Yes Mo

Click [Yes]. Continue to Chapter 2 to walk through reactivating the MyAssistant Server.
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Server Configuration

Chapter 4 — MyAssistant Server Configuration

This chapter walks through reactivating the MyAssistant Server software. When in the configuration manager,
you can verify that all settings are still accurate. This must be done before upgrading MyAssistant on any
workstations.

Read this section carefully:

MyAssistant Server configuration steps:

1. Reactivate the software.
2. Upgrade your MyAssistant database.
3. Step through the Configuration Manager, and verify that the prefilled settings are accurate.

NOTE: Reactivating the software and stepping through the Configuration Manager on the

MyAssistant Server will take approximately 10 minutes.
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Server Configuration

Step 1 - Welcome

If the MyAssistant Configuration wizard isn’t started, open it with the desktop icon or by following this path:
Windows Start > All Programs > MyAssistant > MyAssistant Configuration Manager.

@ MyAssistant Server Configuration Wizard =3 e
| e — | Welcome To The MyAssistant Server L7
Product Activation You may meed the following information to configure the Mybssistant Server;

My fAssistant Database Connection

MyAssistant Database & our MyAssistant customer number and Activation codes

Sage 300 CRE Data Folders & The Windows password For the Administrator user,
Motification E-Mail Account

) . » & Sage 300 CRE Operatar ID and passward that Myassistant will use to access Sage 300 CRE data,
Delivery Options

w The email account which Myassistant will use to send email messages.

7] show Advanced Options @

Mext = Cancel

Only check Show Advanced Options if you:
e Are using a Web Proxy Server.
e Are using a full version of the Microsoft SQL Server database.
o Would like to define the Microsoft SQL Server credentials that will be used to access MyAssistant
data.
If established in a prior version of MyAssistant, the information for the items above will already be entered.
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Server Configuration

Step 2 — Product Activation

The MyAssistant Server must be reactivated. The Product Key and Customer Number may be prefilled.

@ Mydssistant Server Configuration Wizard = &
Welcome Product Activation 7]
| Product Activation | Enter your customer number and server product key to activate My&ssistant Server,
MyAssistant Database Connection Customer Mumber
MyAssistant Database Server Product Key
Sage 300 CRE Data Folders | Use tifeb Proxy Server
Motification E-Mail Account Wb Proxy Settings
Web Proxy address:
Delivery Options
User Mame:
Password:
Domain:
\ Activate

< Back Mext =

If you use a Web Proxy Server, check the box displayed under the Server Product Key field and verify that the
information entered is accurate.

NOTE: The Web Proxy Server checkbox will only appear if you selected Show Advanced Options
in the Welcome Screen (Step 1).

If you use a Web Proxy Server, check the box displayed under the Server Product Key field and verify
that the information entered is accurate.
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Server Configuration

Step 3 — Database Connection

NOTE: This step will only be available if you click [Show Advanced Options] in the Welcome

step.

@ My Assistant Server Configuration Wizard

= 8 X

Welcome

Product Activation

Myissiskant Database Connection

My Assistant Database
Sage 300 CRE Data Folders
Motification E-Mail &ccount

Delivery Options

Connect to the MyAssistant Database

Uze the fields below to enter the computer name where the SOL Server database
is installed and to create a SOL Server user,

Enter the computer that the database is located at:

Server Marne SERVER

Create a username and password For Myassistant bo access
the SGL Server:

User Mame Myfssiskant
stk

Password

Re-enter Passwiord: | FskdkErder

Advanced Connection Setkings

Instance name: IS0
Database name:

Port nurmber: 45512

< Back et =

@

CAUTION: Making changes to this step can break the connection to the MyAssistant database.
Modifying these fields requires advanced knowledge of SQL Server database engines.

This step gives you access to the server name, SQL Server credentials, and SQL Instance and Port
Number MyAssistant uses to connect to the Database.

This step will have all previously entered information prefilled.

Click [Next] to continue.

Upgrade Guide
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Server Configuration

Step 4 — Upgrade the MyAssistant Database

MyAssistant will perform the necessary steps to upgrade your database.

@ MyAssistant Server Configuration Wizard

=]

|C1

Welcome

Product Activation

Myhssistant Database

Sage 300 CRE Data Folders

Mokification E-Mail Account

My Assistant Database

Myassistant needs to upgrade your database to the newest version, This may take

a fenw minutes, Please click Mext to proceed with the upgrade.

|Jpdating database: 80% completed. ..

< Back Mext =

7]

Cancel

Click [Next] to upgrade the database.

Upgrade Guide
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Server Configuration
Step 5 - Sage 300 CRE Data Folders

Verify the information in this step is still accurate. These are the data folders MyAssistant will be able to
monitor, and the Sage 300 CRE credentials MyAssistant will use to access the data.

MyAssistant Server Configuration Wizard

o = £

Welcome Define Sage 300 CRE Data Folders e
Product Activation Enter a Sage 300 CRE operator and password that MyAssistant will use to access Sage 300 CRE data.
Myhssistant Database

Sage 300 CRE User: || |
Sage 300 CRE Data Folders Sage 300 CRE | |
Motification E-Mail Account password: Show characters

Click "Add Data Folder” to select the Sage 300 CRE data folders you would like to monitor with MyAssistant.

h Sage 300 CRE Folder Location Name DSN

4

| Import Sage Database Customizations |

Add Data Folder

| < Back || Mext = | | Cancel |

Click [Next] to continue. If there is more than one data folder entered, you will be prompted to select
which folder you wish to have Database Customizations imported from. If there is only one data folder
specified, Database Customizations will be imported automatically.

If the Sage 300 CRE password entered in this step is set to expire, you will receive a warning message
from MyAssistant. When the password does expire, you will need to update MyAssistant with the new
credentials. Changing the settings so the password never expires is recommended.
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Server Configuration

Step 6 — Notification E-Mail Account

Verify your mail server settings are still accurate. Notification E-mails will originate from the name and E-mail
address specified in this step.

@ My Assistant Server Configuration YWizard = O3l
Welcome Matification E-Mal Account L2
Praduct Activation IIze the following to specify the e-mail account from which notification e-mail

rmeszages wil be sent on this server,

MyAssistant Database Connection -
From Mame: My fssiskant

Myhssistant Database From E-mail Address: | myassistant@graail, conn

Sage 300 CRE Data Folders

T 5 Mail Server Settings
Motification E-Mail Account

) . Cutgoing Mail Server: | smtp.gmail. com: 587
Delivery Options
Usernarme: riyassistant@agrail.com

Password: H——

Show characters

| This server requires an encrypted S5L connection

< Back, Mexk =

The mail server settings will show what was entered the last time the software was configured. If nothing
has changed, click [Next].
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Server Configuration

Step 7 — Delivery Options

NOTE: This step will only be available if you click [Show Advanced Options] in the Welcome
step, or if you re-open the MyAssistant Configuration Manager after the initial configuration.

This step is used to determine when Daily Summary emails will be sent, as well as who will receive
MyAssistant error messages.

@ Myassistant Server Configuration Wizard = @ 2
Welcome Delivery Cptons L2
Product Activation The following settings determine when Daily Surmmary notifications are sent and to

whom error notifications are sent,
MyAssistant Database Connection . i
Deliver summary e-mails at: 4100 am i

MyAssistant Database

Sage 300 CRE Data Folders Send Myhssistant errors to

Matification E-Mail Account Default recipient name: My Assistant

Defaulk recipient E-mail: i i
el Ealins myassiskant@grail, com

Erowse. ..

« Back Finish

The information on this step will be prefilled.

It is recommended that MyAssistant sends error messages to an account that is monitored

daily. This way the user can act on the error in a timely manner.
Click [Finish] to close the MyAssistant Server Configuration Wizard.

Once the Configuration Wizard is closed, the Server portion of the MyAssistant upgrade is complete.
Continue to Chapter 5 to upgrade the MyAssistant Workstation.
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Workstation Upgrade

Upgrading the MyAssistant Drive Mapper

If you use a Mapped Drive (i.e., drive letter “T:”) to access your Sage 300 CRE data or programs files, you
need to upgrade the MyAssistant Drive Mapper. The MyAssistant Drive Mapper is used by the Windows
Service that runs MyAssistant Tasks, to access your Sage 300 CRE database or programs.

How do | know if | am using the Drive Mapper?
Perform the following to determine if you are using the MyAssistant Drive Mapper.
1. Log on to the server where the MyAssistant server is installed
2. Open Windows Explorer
3. Go to the folder where the MyAssistant program files are installed. If you accepted the default
location when installing the software, the MyAssistant program files will be in the following
location:
C:\Program Files (x86)\Innovative Software Design\MyAssistant.
4. Look for a file named InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll in the
MyAssistant, Task Service, or Sender Service folders

If this file exists, you are using the MyAssistant Drive mapper and it will need to be updated in all three
locations (the MyAssistant, Task Service, and Sender Service program folders).

CAUTION: The MyAssistant Drive Mapper must be used if you are using mapped drives to access
your Sage 300 data files or Program Files. If you are using UNC paths and do not use any mapped drives,
you do not need to use the Drive Mapper tool.

Perform the following to upgrade the MyAssistant Drive Mapper:

1. Log on to the computer where the MyAssistant server is installed using a Windows user that has
Administrator or Unlimited privileges.

2. Open the folder containing the MyAssistant installation files. This will be a location you selected when
saving the files. There is no default location.

3. Using Windows Explorer, copy and replace the file
InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll from the Tools >
DriveMapperCommand folder in the MyAssistant installation files to the folder where the MyAssistant
software has been installed. (If you accepted the default location when installing the MyAssistant
software, this location will be C:\Program Files\Innovative Software Design\MyAssistant.)

4. The InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll also needs to be placed
in the following locations:
a. Program Files\Innovative Software Design\MyAssistant\Sender Service
b. Program Files\Innovative Software Design\MyAssistant\Task Service

5. Once you have replaced this file, restart the ISDAdminTaskService and ISDAdminSenderService
from the Windows Services window. Follow the instructions below to do this.

1. Click to open the Start menu and click [Run]

2. In the Run box type services.msc to open the Windows Services window

3. Look down the list for ISDAdminTaskService and ISDAdminSenderService
4. Restart both of these services.

The MyAssistant Drive Mapper tool is now upgraded.
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Workstation Upgrade

Chapter 5 — Upgrading the MyAssistant Workstation(s)

I IMPORTANT: If you are upgrading a Terminal or Citrix Server, please move to Chapter 6.

Perform the following to initiate the MyAssistant Workstation upgrade.

1.

Log on to your Sage 300 MyAssistant workstation with a Windows user that has Administrator or
Unlimited permissions.

Confirm that you have closed all applications and disabled any anti-virus or Firewall software that
may be running.

Using the link provided by Sage Software, download the MyAssistant installation files and save
the .ZIP file to a folder on your machine. If accessible from the workstation, you can use the same
files that were used to upgrade the MyAssistant Server. Perform the following to initiate the
MyAssistant Workstation Upgrade.

a) Open the location of the downloaded MyAssistant Installation files.
b) Unzip the files to a folder on the local drive on the MyAssistant Server.
c) Open the location of the unzipped MyAssistant installation files and double click autorun.hta

4. The Sage 300 CRE MyAssistant Installation hub will open.

Sage 300

Construction and Real Estate

MyAssistant

Version 14.1
» View Installation Guide.

v Install Server.

v Install Workstation. 4

| SageCRE.com | Exit |

Install Workstation — Select [Install Workstation] to perform a MyAssistant workstation upgrade.
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Workstation Upgrade

Step 1 - Welcome

When you select Workstation Install on the MyAssistant splash screen, the Setup Workstation wizard will
appear.

m Myhssistant - Setup Workstation
\Welcome Welcome to the MyAssistant Instaler
Thiz wizard will guide vou through the Mydssistant installation process. You
Inztall Prereqiusites may be azked to restart your system after installing prerequisites.

&  FPrerequisites

®  MyAssistant

Before continuing installation, please cloze all applications [such as Microzoft
Outlook, Wirus Scanners, and Spyware Detectars), since they can interfers
with the My Assigtant inztallabion.

Mest > Cancel

Click [Next] to continue.
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Workstation Upgrade

Step 2 — MyAssistant License Agreement

Read and accept the Innovative Software Design End-User License Agreement. You must accept the
Innovative Software Design License Agreement to use the Sage 300 CRE MyAssistant software.

m Myhssistant - Setup Workstation

License Terms for MyAssistant

License Terms IMPORTANT - READ CAREFULLY: This il
Inztall Preregiusites Software License Agreement (the “Agreement”™)
15 a legal agreement between you - either an
indrndual or a single entity - the " Licensee™) and
Innovative Software Design, Inc. ("ISD™). Ths
Aoreement applies to the computer software, m
machine readable form, that accompames this
Agreement  (the  “Software™), updates,
documentation  and  related  serwices. YOU
AGEEE TO BE BOUND BY THE TEEMS OF
THIZ AGEEEMITT BY CLICEING “I
ACCEPT THE  TERMSE OF THIS
AGEEEMENT', DINMSTALLTNG, COPYING,
OF TEING THE SOFTWAERE. IF YOI DO
NOT AGEEE, DO NOT INETALL, COPT,
OF. TUZE THE SOFTWARE, YOU MATY
EETUEN IT TO TYOUE PLACE CF
PUECHASE FOR A FULL EEFTIND.

W accept the terms in the license agreement

Mest » Cancel |

Click [Next] to continue.
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Workstation Upgrade

Step 3 — Prerequisites for MyAssistant Workstation

The next window displays the prerequisite software that MyAssistant may need to upgrade. If there are no
software updates necessary on the workstation, the Setup Workstation Wizard will skip this step. Once all
prerequisites have been installed, click [Next] to continue with the MyAssistant Workstation Install.

Step 4 - Install the Software

Click [Next] to begin the installation of updated MyAssistant software on the workstation.

m MyAssistant - Setup Workstation E

My Assistant

The default lozation where the MyAsziztant program files will be inztalled
to is C:\Program Filesh nnovative Software Designihy Assistants. You
Inztall Frereqiusites may uze the Browsze buthan to zpecify a different location on gour local
cormputer,
Install Mywdazistant

Select 5 location to ingtall Mydesistant:

C:4%Frogram Files [#86]4 nnovative Software Designhhdy Agsiztant

Browse... |

Mest > Cancel
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Workstation Upgrade

Step 5 - You have Completed Installing MyAssistant
Congratulations. MyAssistant has successfully been upgraded on this machine.

m My Assistant - Setup Workstation

Yol have completed instaling MyAssistant

o Congratulations! v'ou have finished ingtalling Mopsszzistant. When you launch
Install Prereqiuzites Mt zzistant for the firzt time pou will be asked to provide zome basic information
to activate and connect to the Mydasistant Server.

Finizhed

Firish |

Click [Finish] to close the setup wizard.
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Workstation Configuration

Chapter 6 — MyAssistant Workstation Configuration

E] NOTE: Depending on a number of settings, you may not need to reactivate the Workstation. If
this is the case, MyAssistant will open ready to use.

Step 1 — Welcome Screen

Double click on the MyAssistant icon on the desktop to open the MyAssistant software.

@ Mydssistant User Configuration 'Wizard = &
| e | Welcormes To MyAssistant e
Product Activation You may need to the following information to configure MyAssistant:

Sage 300 CRE Data Folders

Yfour Settings & Yfour Mydssistant customer number and Activation codes

| Showe Advanced Options

Mext >

If there is not a shortcut on the desktop, follow the path below to open MyAssistant:

Open the Windows Start Menu > All Programs > MyAssistant (File) > MyAssistant
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Workstation Configuration

Step 2 — Product Activation

You must activate MyAssistant in order to use it. A working internet connection is required to complete this
step. Your customer number and product key may already be entered. Reactivate before clicking next.

@ Myfssistant User Configuration Wizard o B=OEE
welcome Froduct Activation
| Product Activation | Enter your customer number and user product key to activate My&ssistant for user
Adrrinistrator on this computer, The Myassistant product key determines the
Sage 300 CRE Data Folders Mydzsistant features available to user Administrator on this computer,
Your Settings Zustomer Mumber
My Assiskant Product ey

W | Use Web Proxy Server

Web Proxy Setkings
Web Proxy fddress:

User Marme:
Password:

Darnain:

N Activate Activate Later

« Back Mextk =

E] NOTE: The Web Proxy Server connection fields will only be available if you clicked [Show Advanced
Options] in the Welcome step. Verify the information and click [Next].
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Workstation Configuration

Step 3 — Entering Sage 300 CRE Data Folder Information

The information in this step will be prefilled. Verify that it is accurate.

@ My Assiskant User Configuration Wizard = =R
\Welcome Ciefine Sage 200 CRE Data Folders @
Product Activation Enter your Sage 300 CRE user name and password.,

Sage 300 CRE Data Folders |

Timberline User: | |

Your Setkings

Timberline password: | |

Show characters

Click.in the Sage 300 CRE Location column to specify a data Folder, Please verify any prefilled
Sage 300 CRE data Folder paths,

Ignore | Sage 300 CRE Folder Location | Mame
I C:\ProgramDatalSAGEYTIMBERLIME OFFIC| .. | Timberline Construction

« Back Mext = Cancel

Click [Next] if all information is correct.
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Workstation Configuration

Step 4 — User Profile

This step shows the personal information for the Windows user on this workstation.

@ Mydissistant User Configuration Wizard = 3 2
welcome Your Personal Information
Product Activation Enter the person's name and e-mail address for the current windows User,

Sage 300 CRE Data Folders

Your Settings Windows User: Administrakor

Your Marme:

Wour E-mail Address:

W | Showe Motifications in the Sage 300 CRE Deskkop
W | Display Myassistant Alerts in the System Tray

W | Show Myassistant Tile on the Deskkop

<Back Fish | [, Concel ]

Sage 300 CRE MyAssistant will start upon clicking Finish in the wizard.
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Terminal Server Upgrade

Chapter 7 — Upgrading a Terminal Server

E CAUTION: This chapter is written for clients who will be running the MyAssistant Server and at
least one MyAssistant User on a Terminal or Citrix Server.

What is Involved

Here is a list of what needs to be done to upgrade MyAssistant on a Terminal or Citrix Server:
Log onto the Server as a System Administrator.

Run the MyAssistant Server installation to upgrade.

Activate MyAssistant with a Server Product Key.

Log onto the machine with a Windows user who will run the software.

Open the MyAssistant user Application.

Depending on a number of settings, the user may need to reactivate the software.

IZESEEC NS

Before Upgrading

Before MyAssistant can be upgraded on any accounts other than the administrator, permissions must be
given to specific files. Find a list below of these files. The paths have been provided for your convenience,
however they may vary slightly.

If on Windows 2003:

e C:\Documents and Settings > All Users > Application Data
e C:\Program Files\Innovative Software Design

OR
e C:\Program Files(x86)\Innovative Software Design

If on Windows 2008:

e C:\Program Data
e C:\Program Files\Innovative Software Design
OR
e C:\Program Files(x86)\Innovative Software Design

| IMPORTANT: Permissions need to be given to these folders prior to activating any MyAssistant

users on this machine.

Upgrading the MyAssistant Server
Complete to Chapters 1 and 2 for upgrading the MyAssistant Server. When you have completed Chapter
2, return to this Chapter to activate the MyAssistant User Software on this Terminal or Citrix Server.

Activating the MyAssistant Workstation
Once the MyAssistant Server is installed and activated, log onto the Terminal or Citrix Server as the
Windows user who will be using the MyAssistant software.

e |If there is a MyAssistant icon on the desktop, double click to open the User Configuration

Manager.
e |If there is not an icon on the desktop follow this path:
Start > All Programs > Sage > MyAssistant (folder) > MyAssistant

When the User Configuration Manager is open complete Chapter 4 to activate the MyAssistant
workstation.
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Test the upgrade

Chapter 7 — Test the Upgrade

The last step in the upgrade process is to confirm that MyAssistant is working properly. Perform the
following to test this:

Access Sage 300 CRE Data

Noobkhwdd =

Open the MyAssistant Designer software from a MyAssistant workstation.

Open an activated MyAssistant Task.

Move to the Email step in the Edit Task window.

On the right side of the window is a list of available Sage 300 CRE database records.
Expand the very first record.

Right click on the first field and select [Browse Data].

The data contained in the field should be displayed in the Browse Data window.

Troubleshooting

1.

2.

Perform the following if data is not displayed in the Browse window.

a. Select File > [Options] to open the Options window.

b. Move to the Sage 300 CRE Data Folder step.

c. Click [Test Connection] to confirm that the Sage 300 CRE credentials entered are able to
access the Sage 300 CRE data. If the test fails, enter updated credentials.

Contact support if an error is displayed when browsing data

Run Tasks and Receive Email Messages

1.
2.

3.

Open the MyAssistant software from a MyAssistant workstation.

Browse to an activated Task. If possible, select a Task with an attached Crystal Report that is
being sent to you (edit the recipient list as needed).

Right click on the Task and click [Run and Send].

Troubleshooting

1.

The Task run doesn't finish

a. Log onto the MyAssistant Server.

b. Open the Windows Services window (Start > Run > type: Services.msc).

c. Look for the ISDAdminTask and ISDAdminSender services. Confirm both are started.

Email not received

a. Open the Windows Services window (Start > Run > type: Services.msc).

b. Look for the ISDAdminSenderService. Right click on the service and select [Properties].

c. Click the [Log On] tab.

d. Select [This account] and enter a Windows user that is associated with a person who is an
administrator in the Sage 300 CRE software.

e. Click [OK] and then restart the Service.

Report not attached to email
a. Perform the steps outline for # 2 above
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Conclusion

Conclusion

This completes the upgrade of the Sage 300 CRE MyAssistant software. The next step is to learn your way
around the updated software. Please refer to the User Guide for information on using MyAssistant.
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